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MSG 006 - FD03 FLIGHT PLAN REVISION 

MSG INDEX 1 
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MSG NO. TITLE 3 
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15 
16 
17 
18 

006  FD03 FLIGHT PLAN REVISION 
007  FD03 MISSION SUMMARY 
008  FD03 RNDZ PACKAGE 
009  FD03 TRANSFER MESSAGE 
010  STOWAGE LOCATIONS FOR FD03 PLAN (GMT 154/155) 
011  FD03 EVA DELTAS 
012  1J SSRMS AND JEM RMS DOUG SETUP NOTES 
014  OSTPV REFERENCE AND TROUBLESHOOTING 
015  H2O OPS CUE CARD, REV B 
 
1. Cryo Config 14 

For today's cryo config, O2 and H2 tank 4 will be active with dual heaters. 
 
R1    O2, H2 MANF VLV TK2 (two) - OP (tb-OP) 

 
2. Simo Dump Details 19 

At MET 1/14:10 perform a simo dump using SUPPLY/WASTE WATER DUMP (ORB 
OPS, 

20 
ECLS) p. 5-2.  MCC will TMBU FDA in steps B and K.  Waste dump valve open 

time will be ~ 15 minutes and will dump the waste tank to 5%.  Supply dump valve open 
time will be 60 minutes. 

21 
22 
23 
24  

3. Shuttle Condensate Collection Details 25 
At MET 1/18:00 perform SETUP of SHUTTLE CONDENSATE COLLECTION (ORB 
OPS, 

26 
ECLS) p. 5-36.  The Y-Y Condensate Hose and CWC are located in MF71M.  

Report CWC serial number to MCC. 
27 
28 
29 

31 
32 
33 
34 
35 
36 
37 
38 
39 
40 
41 
42 

44 
45 
46 

48 
49 
50 

 
4. ADI Pointer Oscillations 30 

After reviewing rate data from NC1 and NC2, the ADI is working as expected.  
Oscillations in IMU body rates were observed during the NC1 and NC2 burns that would 
register and in some cases exceed the rate scale of the ADI in LOW for OPS 2 (+/- 0.2 
deg/s).  These oscillations have been seen in the data from previous flights, and the 
update rate of the ADI is fast enough that it would be displayed. 
 
The OPS 2 ADI rate scales were changed with OI-32 (scales are now LOW: +/- 0.2 
deg/s, MED: +/- 1, HIGH: +/- 5) to aid crew monitoring of more quiescent on-orbit rates.  
OPS 1 and 3 ADI rate scales remain the same as OI-30 (scales are LOW: +/-1 deg/s, 
MED: +/- 5, HIGH: +/- 10).  MCC recommends placing the ADI rate switch in MED or 
HIGH for future orbit OMS burns. 

 
5. DOUG Setup Notes 43 

MSG012 (17-0279A) was uplinked to the ISS pre-launch.  It has been uplinked to the 
Shuttle for your reference. 

 
6. OSTPV Notes 47 

MSG014 has some reference material and troubleshooting tips for OSTPV.  We did not 
print this message due to the number of images in it. 

 
7. REPLACE PAGES 2-6, 2-8 and 3-20 THROUGH 3-29. 51 

END OF PAGE 1 OF 13, MSG 006 
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MS2

SLEEP

~

SUPPLY/WASTE WATER DUMP
 (ORB OPS, ECLS) INIT
 Ref. MSG 006, Item 2

SUPPLY/WASTE WATER DUMP
 (ORB OPS, ECLS) TERM

POST-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

FLIGHT SLEEP LOG (ORB OPS, SDBI)

POST-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

MS3

SLEEP

~

POST-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

~

MS4

SLEEP

~

POST-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

EXERCISE
~

FE-2 UP

SLEEP

~

POST-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

~

Notes

3-21

GARAN FOSSUM HOSHIDE CHAMITOFF

03
            REPLANNED

STS-124 FD
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MS2

SLEEP

~

SUPPLY/WASTE WATER DUMP
 (ORB OPS, ECLS) INIT
 Ref. MSG 006, Item 2

SUPPLY/WASTE WATER DUMP
 (ORB OPS, ECLS) TERM

POST-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

FLIGHT SLEEP LOG (ORB OPS, SDBI)

POST-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

MS3

SLEEP

~

POST-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

~

MS4

SLEEP

~

POST-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

EXERCISE
~

FE-2 UP

SLEEP

~

POST-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

~

Notes



06/02/08  03:34:07

FLT PLN/124/FLT     

KELLY HAM NYBERG

03

< Ti TIG 1/18:14
RNDZ PET 00:00
AT MET 1/18:14

(Ti)

< NC4 TIG 1/16:42

UPDATE
TFL 192, CFG 763

UPLINK
β21 Only
Box 30,40,41,50

            REPLANNED

3-22

STS-124 FD

     

14:00

15:00
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GMT
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CDR

RENDEZVOUS TIMELINE
 (RNDZ, RENDEZVOUS T/L)

~

APPROACH
 (RNDZ, CUE CARD)

~

PLT

RENDEZVOUS TIMELINE
 (RNDZ, RENDEZVOUS T/L)

~

APPROACH
 (RNDZ, CUE CARD)

~

MS1

RENDEZVOUS TIMELINE
 (RNDZ, RENDEZVOUS T/L)

~

APPROACH
 (RNDZ, CUE CARD)

~

Notes

3-22

KELLY HAM NYBERG

03

< Ti TIG 1/18:14
RNDZ PET 00:00
AT MET 1/18:14

(Ti)

< NC4 TIG 1/16:42

UPDATE
TFL 192, CFG 763

UPLINK
β21 Only
Box 30,40,41,50

            REPLANNED
STS-124 FD

     

14:00

15:00

16:00

17:00

GMT
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06/02
(154)
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~

CDR

RENDEZVOUS TIMELINE
 (RNDZ, RENDEZVOUS T/L)

~

APPROACH
 (RNDZ, CUE CARD)

~

PLT

RENDEZVOUS TIMELINE
 (RNDZ, RENDEZVOUS T/L)

~

APPROACH
 (RNDZ, CUE CARD)

~

MS1

RENDEZVOUS TIMELINE
 (RNDZ, RENDEZVOUS T/L)

~

APPROACH
 (RNDZ, CUE CARD)

~

Notes
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FLT PLN/124/FLT     

GARAN FOSSUM HOSHIDE CHAMITOFF

03
            REPLANNED

3-23

STS-124 FD

     

14:00

15:00

16:00

17:00

GMT

Date
06/02
(154)

     

16:00
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MS2

POST-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

APPROACH
 (RNDZ, CUE CARD)

~

EMU REMOVAL
 (EVA, AIRLOCK CONFIG)

EXERCISE

SSV  OUTRATE - 3

SHUTTLE CONDENSATE COLLECTION
 (ORB OPS, ECLS) SETUP
 Ref. MSG 006, Item 3

SSP1 OIU PWR - OIU 1 ON (tb-UP)

MS3

POST-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

~

P/TV02 DOCK
 (P/TV, SCENES) OPS

~

P/TV02 DOCK 
 (P/TV, SCENES) SETUP

EMU REMOVAL
 (EVA, AIRLOCK CONFIG)

EXERCISE

MS4

APPROACH
 (RNDZ, CUE CARD)

~

EXERCISE

~

RENDEZVOUS TIMELINE
 (RNDZ, RENDEZVOUS T/L)

TRANSFER UPDATE
 Ref. MSG 009

FE-2 UP

POST-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

~

EXERCISE

RENDEZVOUS TIMELINE
 (RNDZ, RENDEZVOUS T/L)

APPROACH
 (RNDZ, CUE CARD)

~

Notes

3-23

GARAN FOSSUM HOSHIDE CHAMITOFF

03
            REPLANNED

STS-124 FD

     

14:00

15:00
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17:00
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(154)

     

16:00
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~

MS2

POST-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

APPROACH
 (RNDZ, CUE CARD)

~

EMU REMOVAL
 (EVA, AIRLOCK CONFIG)

EXERCISE

SSV  OUTRATE - 3

SHUTTLE CONDENSATE COLLECTION
 (ORB OPS, ECLS) SETUP
 Ref. MSG 006, Item 3

SSP1 OIU PWR - OIU 1 ON (tb-UP)

MS3

POST-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

~

P/TV02 DOCK
 (P/TV, SCENES) OPS

~

P/TV02 DOCK 
 (P/TV, SCENES) SETUP

EMU REMOVAL
 (EVA, AIRLOCK CONFIG)

EXERCISE

MS4

APPROACH
 (RNDZ, CUE CARD)

~

EXERCISE

~

RENDEZVOUS TIMELINE
 (RNDZ, RENDEZVOUS T/L)

TRANSFER UPDATE
 Ref. MSG 009

FE-2 UP

POST-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

~

EXERCISE

RENDEZVOUS TIMELINE
 (RNDZ, RENDEZVOUS T/L)

APPROACH
 (RNDZ, CUE CARD)

~

Notes



06/02/08  03:34:07

FLT PLN/124/FLT     

KELLY HAM NYBERG

03

RETURN TO FLIGHT PLAN

UPDATE
TFL 184

UPLINK
β21 Only
Box 40,41,50

  - DOCKING(1/20:52)

<

SSV OUTRATE - 2When ISS is GO for attitude control,
DAP:FREE

            REPLANNED

3-24

STS-124 FD

     

18:00

19:00

20:00

21:00

GMT
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06/02
(154)
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CDR

APPROACH
 (RNDZ, CUE CARD)

~

MNVR BIAS -XLV -ZVV
 TG=2  BV=5  P=165  Y=354  OM=184
 Init TRK, DAP:FREE > 2 sec, then 
 DAP:A12/AUTO/VERN

JOINT OPS: 2.104 HATCH OPENING
& STS/ISS DUCT INSTALLATION
 √MCC Step 1 complete,
  Steps 2-11,14-15. MCC-H will
  perform steps 12-13,16.

KONNICHIWA

SAFETY BRIEFING

PRIORITY PWRDN GRP B(ORB PKT,PRI PWRDN)
 Steps 6,12 (In Step 6, Single G2)
 (In Step 12, IMU 3 STBY - ITEM 23 EXEC) 
 06 S TRK PWR -Z - OFF

JOINT OPS: 3.120 PREBREATHE USING
SHUTTLE O2 SETUP
 Step 2-end
 Ref. MSG 010

~

PLT

APPROACH
 (RNDZ, CUE CARD)

~

KONNICHIWA

SAFETY BRIEFING

JOINT OPS: 2.104 HATCH OPENING
& STS/ISS DUCT INSTALLATION
 √MCC Step 1 complete,
  Steps 2-11,14-15. MCC-H will
  perform steps 12-13,16.

L17 Check MCIU filter screen

EVA TRANSFER TO ISS
 (EVA, AIRLOCK CONFIG)
 Ref. Transfer List: Items 1-4
 Ref. MSG 011

~

SSPTS ODS CONNECTOR VERIF
 A15  ODS MATE X1,X2 (two) - ON
                 √MCC then - OFF
PRIORITY PWRDN GRP B(ORB PKT,PRI PWRDN)
 Steps 6,12 (In Step 6, Single G2)
 (In Step 12, IMU 3 STBY - ITEM 23 EXEC) 
 06 S TRK PWR -Z - OFF

MS1

APPROACH
 (RNDZ, CUE CARD)

~

POST DOCKING HATCH LEAK CHECK
 (RNDZ, APDS)

KONNICHIWA

SAFETY BRIEFING

EXERCISE
~

SODF TRANSFER
 Ref. Transfer List: Item 28

JOINT OPS: 6.107 PCS S/U-SHUTTLE

POST RNDZ PGSC CONFIG
 Configure PGSCs per EVA/RMS
 usage chart

Notes

3-24

KELLY HAM NYBERG

03

RETURN TO FLIGHT PLAN

UPDATE
TFL 184

UPLINK
β21 Only
Box 40,41,50

  - DOCKING(1/20:52)

<

SSV OUTRATE - 2When ISS is GO for attitude control,
DAP:FREE

            REPLANNED
STS-124 FD

     

18:00

19:00

20:00

21:00

GMT

Date
06/02
(154)
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21:00
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23:00

00:00

MET
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-
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V

CDR

APPROACH
 (RNDZ, CUE CARD)

~

MNVR BIAS -XLV -ZVV
 TG=2  BV=5  P=165  Y=354  OM=184
 Init TRK, DAP:FREE > 2 sec, then 
 DAP:A12/AUTO/VERN

JOINT OPS: 2.104 HATCH OPENING
& STS/ISS DUCT INSTALLATION
 √MCC Step 1 complete,
  Steps 2-11,14-15. MCC-H will
  perform steps 12-13,16.

KONNICHIWA

SAFETY BRIEFING

PRIORITY PWRDN GRP B(ORB PKT,PRI PWRDN)
 Steps 6,12 (In Step 6, Single G2)
 (In Step 12, IMU 3 STBY - ITEM 23 EXEC) 
 06 S TRK PWR -Z - OFF

JOINT OPS: 3.120 PREBREATHE USING
SHUTTLE O2 SETUP
 Step 2-end
 Ref. MSG 010

~

PLT

APPROACH
 (RNDZ, CUE CARD)

~

KONNICHIWA

SAFETY BRIEFING

JOINT OPS: 2.104 HATCH OPENING
& STS/ISS DUCT INSTALLATION
 √MCC Step 1 complete,
  Steps 2-11,14-15. MCC-H will
  perform steps 12-13,16.

L17 Check MCIU filter screen

EVA TRANSFER TO ISS
 (EVA, AIRLOCK CONFIG)
 Ref. Transfer List: Items 1-4
 Ref. MSG 011

~

SSPTS ODS CONNECTOR VERIF
 A15  ODS MATE X1,X2 (two) - ON
                 √MCC then - OFF
PRIORITY PWRDN GRP B(ORB PKT,PRI PWRDN)
 Steps 6,12 (In Step 6, Single G2)
 (In Step 12, IMU 3 STBY - ITEM 23 EXEC) 
 06 S TRK PWR -Z - OFF

MS1

APPROACH
 (RNDZ, CUE CARD)

~

POST DOCKING HATCH LEAK CHECK
 (RNDZ, APDS)

KONNICHIWA

SAFETY BRIEFING

EXERCISE
~

SODF TRANSFER
 Ref. Transfer List: Item 28

JOINT OPS: 6.107 PCS S/U-SHUTTLE

POST RNDZ PGSC CONFIG
 Configure PGSCs per EVA/RMS
 usage chart

Notes
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FLT PLN/124/FLT     

GARAN FOSSUM HOSHIDE CHAMITOFF

03

RETURN TO FLIGHT PLAN

  - DOCKING(1/20:52)

<

~ ~

            REPLANNED

C Ref:STS-124/1J EMU CONSUMABLES
      TRACKING CC

3-25

STS-124 FD

     

18:00

19:00
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21:00
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MS2

APPROACH
 (RNDZ, CUE CARD)

~

KONNICHIWA

SAFETY BRIEFING

EVA TRANSFER TO ISS
 (EVA, AIRLOCK CONFIG)
 Ref. Transfer List: Items 1-4
 Ref. MSG 011

EVA SYS: 1.307 REBA INSTL/RMVL
 INSTALL C

POST RNDZ PGSC CONFIG
 Configure PGSCs per EVA/RMS
 usage chart

JOINT OPS: 6.107 PCS S/U-SHUTTLE

MS3

P/TV02 DOCK
 (P/TV, SCENES) OPS

~

AIRLOCK PREP FOR INGRESS
BOOSTER FAN ACTIVE
 (RNDZ, APDS)

P/TV04 INGRESS/EGRESS (S/U)
 (PHOTO/TV, SCENES)

P/TV04 INGRESS/EGRESS (OPS)
 (PHOTO/TV, SCENES)

KONNICHIWA

SAFETY BRIEFING

EVA TRANSFER TO ISS
 (EVA, AIRLOCK CONFIG)
 Ref. Transfer List: Items 1-4
 Ref. MSG 011

EVA SYS: 1.307 REBA INSTL/RMVL
 INSTALL C

MS4

APPROACH
 (RNDZ, CUE CARD)

~

POST DOCKING HATCH LEAK CHECK
 (RNDZ, APDS)

AIRLOCK PREP FOR INGRESS
BOOSTER FAN ACTIVE
 (RNDZ, APDS)

KONNICHIWA

SAFETY BRIEFING

JOINT OPS: 2.104 HATCH OPENING
& STS/ISS DUCT INSTALLATION
 √MCC Step 1 complete,
  Steps 2-11,14-15. MCC-H will
  perform steps 12-13,16.

P/TV05 ISS INTERNAL OPS
 (PHOTO/TV, SCENES)
 Perform BPSMU and RWS Setup

MIDDECK TRANSFER
 Ref. Transfer List: 
 Items 6,25,& 7.1

FE-2 UP

APPROACH
 (RNDZ, CUE CARD)

~

JOINT OPS: 6.109 H/L ICOM AUDIO
 Perform Steps 1,5,6. In Step 5,
 do 2-way voice ck on PAGE loop.

JOINT OPS: 2.104 HATCH OPENING
& STS/ISS DUCT INSTALLATION
 √MCC Step 1 complete,
  Steps 2-11,14-15. MCC-H will
  perform steps 12-13,16.

KONNICHIWA

SAFETY BRIEFING

IELK REMOVAL & TRANSFER
 Ref. Transfer List: Item 14.2

IELK INSTALL & C/O
 Ref. RODF ~

Notes

3-25

GARAN FOSSUM HOSHIDE CHAMITOFF

03

RETURN TO FLIGHT PLAN

  - DOCKING(1/20:52)

<

~ ~

            REPLANNED

C Ref:STS-124/1J EMU CONSUMABLES
      TRACKING CC

STS-124 FD
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MS2

APPROACH
 (RNDZ, CUE CARD)

~

KONNICHIWA

SAFETY BRIEFING

EVA TRANSFER TO ISS
 (EVA, AIRLOCK CONFIG)
 Ref. Transfer List: Items 1-4
 Ref. MSG 011

EVA SYS: 1.307 REBA INSTL/RMVL
 INSTALL C

POST RNDZ PGSC CONFIG
 Configure PGSCs per EVA/RMS
 usage chart

JOINT OPS: 6.107 PCS S/U-SHUTTLE

MS3

P/TV02 DOCK
 (P/TV, SCENES) OPS

~

AIRLOCK PREP FOR INGRESS
BOOSTER FAN ACTIVE
 (RNDZ, APDS)

P/TV04 INGRESS/EGRESS (S/U)
 (PHOTO/TV, SCENES)

P/TV04 INGRESS/EGRESS (OPS)
 (PHOTO/TV, SCENES)

KONNICHIWA

SAFETY BRIEFING

EVA TRANSFER TO ISS
 (EVA, AIRLOCK CONFIG)
 Ref. Transfer List: Items 1-4
 Ref. MSG 011

EVA SYS: 1.307 REBA INSTL/RMVL
 INSTALL C

MS4

APPROACH
 (RNDZ, CUE CARD)

~

POST DOCKING HATCH LEAK CHECK
 (RNDZ, APDS)

AIRLOCK PREP FOR INGRESS
BOOSTER FAN ACTIVE
 (RNDZ, APDS)

KONNICHIWA

SAFETY BRIEFING

JOINT OPS: 2.104 HATCH OPENING
& STS/ISS DUCT INSTALLATION
 √MCC Step 1 complete,
  Steps 2-11,14-15. MCC-H will
  perform steps 12-13,16.

P/TV05 ISS INTERNAL OPS
 (PHOTO/TV, SCENES)
 Perform BPSMU and RWS Setup

MIDDECK TRANSFER
 Ref. Transfer List: 
 Items 6,25,& 7.1

FE-2 UP

APPROACH
 (RNDZ, CUE CARD)

~

JOINT OPS: 6.109 H/L ICOM AUDIO
 Perform Steps 1,5,6. In Step 5,
 do 2-way voice ck on PAGE loop.

JOINT OPS: 2.104 HATCH OPENING
& STS/ISS DUCT INSTALLATION
 √MCC Step 1 complete,
  Steps 2-11,14-15. MCC-H will
  perform steps 12-13,16.

KONNICHIWA

SAFETY BRIEFING

IELK REMOVAL & TRANSFER
 Ref. Transfer List: Item 14.2

IELK INSTALL & C/O
 Ref. RODF ~

Notes
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03

EVA SYS: 1.206 10.2 PSIA CAMPOUT MASK
PREBREATHE Continued on Page 3-28

            REPLANNED

D SSPTS OPCU ACT
  On MCC GO:A15 OPCU 1,2 CONV(two) - ON
            R1  MN BUS TIE B - ON(tb-ON)
                           C - ON(tb-ON)

3-26
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EVA PROCEDURE REVIEW
 
 Ref:  EVA 1 BRIEFING CARD
        (EVA, TIMELINES)

EXERCISE

PRIVATE MEDICAL CONFERENCE

JOINT OPS: 3.120 PREBREATHE USING
SHUTTLE O2 SETUP
 Step 2-end
 Ref. MSG 010

~

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)
   √Hum Seps for H2O Accumulation

~

MO69M LEH O2 8 vlv - CL 

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

PLT

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

~

EVA PROCEDURE REVIEW
 
 Ref:  EVA 1 BRIEFING CARD
        (EVA, TIMELINES)

EVA TRANSFER TO ISS
 (EVA, AIRLOCK CONFIG)
 Ref. Transfer List: Items 1-4
 Ref. MSG 011

~

SSPTS OPCU ACT D

EXERCISE

MS1

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

~

EVA PROCEDURE REVIEW
 
 Ref:  EVA 1 BRIEFING CARD
        (EVA, TIMELINES)

EXERCISE

~

ASSY OPS: 3.129 IWIS INSTALLATION IN
SHUTTLE AIRLOCK
 Steps 1.1-1.6, 1.10
 Ref. MSG 010

MIDDECK TRANSFER
 Ref. Transfer List: Item 31

Notes

3-26

KELLY HAM NYBERG

03

EVA SYS: 1.206 10.2 PSIA CAMPOUT MASK
PREBREATHE Continued on Page 3-28

            REPLANNED

D SSPTS OPCU ACT
  On MCC GO:A15 OPCU 1,2 CONV(two) - ON
            R1  MN BUS TIE B - ON(tb-ON)
                           C - ON(tb-ON)
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CDR

EVA PROCEDURE REVIEW
 
 Ref:  EVA 1 BRIEFING CARD
        (EVA, TIMELINES)

EXERCISE

PRIVATE MEDICAL CONFERENCE

JOINT OPS: 3.120 PREBREATHE USING
SHUTTLE O2 SETUP
 Step 2-end
 Ref. MSG 010

~

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)
   √Hum Seps for H2O Accumulation

~

MO69M LEH O2 8 vlv - CL 

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

PLT

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

~

EVA PROCEDURE REVIEW
 
 Ref:  EVA 1 BRIEFING CARD
        (EVA, TIMELINES)

EVA TRANSFER TO ISS
 (EVA, AIRLOCK CONFIG)
 Ref. Transfer List: Items 1-4
 Ref. MSG 011

~

SSPTS OPCU ACT D

EXERCISE

MS1

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

~

EVA PROCEDURE REVIEW
 
 Ref:  EVA 1 BRIEFING CARD
        (EVA, TIMELINES)

EXERCISE

~

ASSY OPS: 3.129 IWIS INSTALLATION IN
SHUTTLE AIRLOCK
 Steps 1.1-1.6, 1.10
 Ref. MSG 010

MIDDECK TRANSFER
 Ref. Transfer List: Item 31

Notes
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EVA SYS: 1.305 EQUIP LOCK PREP
  
 Ref: STS-124/1J EMU CONSUMABLES
      TRACKING CC

EVA SYS: 1.403 REBA PWRD H/W CK
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EVA PROCEDURE REVIEW
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EVA PROCEDURE REVIEW
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TRANSFER BRIEF
 Call down status to MCC

DAILY STS/ISS CREW
  TRANSFER TAGUP

PLAYBACK (DIGITAL)
 (PHOTO/TV, CUE CARD)
 DOCKING VIDEO
 KU TDRW (00:05-00:33)

MIDDECK TRANSFER
 Ref. Transfer List:
 Items 6,25,& 7.1

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

FE-2 UP

IELK INSTALL & C/O
 Ref. RODF

~

EVA PROCEDURE REVIEW
 
 Ref:  EVA 1 BRIEFING CARD
        (EVA, TIMELINES)

PRE SLEEP

PRE SLEEP

DAILY PLANNING CONFERENCE

EVENING PREP WORK

~

Notes
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 DOCKING VIDEO
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 Ref. RODF

~

EVA PROCEDURE REVIEW
 
 Ref:  EVA 1 BRIEFING CARD
        (EVA, TIMELINES)

PRE SLEEP

PRE SLEEP

DAILY PLANNING CONFERENCE

EVENING PREP WORK

~

Notes



06/02/08  03:34:07

FLT PLN/124/FLT     

KELLY HAM NYBERG

03
            REPLANNED

WAKE UP AT 2/13:30

3-28

STS-124 FD

     

02:00

03:00

04:00

05:00

GMT

Date
06/03
(155)

     

04:00

05:00

06:00

07:00

08:00

MET

Day 002
W E Z

T
D
R
S

~

~

~

D
/
N

O
R
B

3
5

3
6

3
7

~

~

B
I
A
S
 
-
X
L
V
 
-
Z
V
V

S
T
S
 
A
T
T

CDR

SLEEP

~

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

EVA SYS: 1.206 10.2 PSIA CAMPOUT MASK
PREBREATHE 
 Steps 1-16
  
 Ref: EVA 1 TOOL CONFIG
       (EVA, TIMELINES)

~

PLT

SLEEP

~

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

~

MS1

SLEEP

~

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

~

Notes

3-28

KELLY HAM NYBERG

03
            REPLANNED

WAKE UP AT 2/13:30

STS-124 FD

     

02:00

03:00

04:00

05:00

GMT

Date
06/03
(155)

     

04:00

05:00

06:00

07:00

08:00

MET

Day 002
W E Z

T
D
R
S

D
/
N

O
R
B

3
5

3
6

3
7

S
T
S
 
A
T
T~

~

B
I
A
S
 
-
X
L
V
 
-
Z
V
V

CDR

SLEEP

~

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

EVA SYS: 1.206 10.2 PSIA CAMPOUT MASK
PREBREATHE 
 Steps 1-16
  
 Ref: EVA 1 TOOL CONFIG
       (EVA, TIMELINES)

~

PLT

SLEEP

~

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

~

MS1

SLEEP

~

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

~

Notes



06/02/08  03:34:07

FLT PLN/124/FLT     

GARAN FOSSUM HOSHIDE CHAMITOFF

03

EVA SYS: 1.206 10.2 PSIA CAMPOUT
MASK PREBREATHE 
 Steps 1-16
  
 Ref: EVA 1 TOOL CONFIG
       (EVA, TIMELINES)

            REPLANNED

WAKE UP AT 2/13:30

3-29

STS-124 FD

     

02:00

03:00

04:00

05:00

GMT

Date
06/03
(155)

     

04:00

05:00

06:00

07:00

08:00

MET

Day 002
W E Z

T
D
R
S

~

~

~

D
/
N

O
R
B

3
5

3
6

3
7

~

~

B
I
A
S
 
-
X
L
V
 
-
Z
V
V

S
T
S
 
A
T
T

MS2

SLEEP

~

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

EVA SYS: 1.206 10.2 PSIA
CAMPOUT MASK PREBREATHE
 
REF: EVA 1 TOOL CONFIG
      (EVA, TIMELINES)

~

MS3

SLEEP

~

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

EVA SYS: 1.206 10.2 PSIA
CAMPOUT MASK PREBREATHE
 
REF: EVA 1 TOOL CONFIG
      (EVA, TIMELINES)

~

MS4

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

~

SLEEP

~

FE-2 UP

~

PRE SLEEP

SLEEP (8.5)

~

Notes

3-29

GARAN FOSSUM HOSHIDE CHAMITOFF

03

EVA SYS: 1.206 10.2 PSIA CAMPOUT
MASK PREBREATHE 
 Steps 1-16
  
 Ref: EVA 1 TOOL CONFIG
       (EVA, TIMELINES)

            REPLANNED

WAKE UP AT 2/13:30

STS-124 FD

     

02:00

03:00

04:00

05:00

GMT

Date
06/03
(155)

     

04:00

05:00

06:00

07:00

08:00

MET

Day 002
W E Z

T
D
R
S

D
/
N

O
R
B

3
5

3
6

3
7

S
T
S
 
A
T
T~

~

B
I
A
S
 
-
X
L
V
 
-
Z
V
V

MS2

SLEEP

~

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

EVA SYS: 1.206 10.2 PSIA
CAMPOUT MASK PREBREATHE
 
REF: EVA 1 TOOL CONFIG
      (EVA, TIMELINES)

~

MS3

SLEEP

~

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

EVA SYS: 1.206 10.2 PSIA
CAMPOUT MASK PREBREATHE
 
REF: EVA 1 TOOL CONFIG
      (EVA, TIMELINES)

~

MS4

PRE-SLEEP ACTIVITY
 (ORB OPS, CREW SYS)

~

SLEEP

~

FE-2 UP

~

PRE SLEEP

SLEEP (8.5)

~

Notes



MSG 007 - FD03 MISSION SUMMARY 

Good Morning Discovery!!! 1 
2 
3 
4 
5 
6 

Welcome to Rendezvous Day!   
The station crew is anxiously awaiting your arrival!!!! 
 
YOUR CURRENT ORBIT IS: 183 X 173 NM 
 
NOTAMS: 7 

8 
9 

10 
11 
12 
13 
14 
15 
16 
17 
18 

EDW  –  LAKEBED RUNWAY 15/33 ELS ONLY.  OTHER LAKEBED RWYS RED. 
NOR –  LAKEBED RUNWAYS GREEN. 
NTU –  NGU TACAN CH CHANGED TO 86Y. 
YJT  –  TACAN CH 78 DME ONLY. 
HAW  –  RWY 31 CLOSED. RWY 13 TODA 8,994’. 
WAK  –  CLOSED.  NOT USABLE. 
IKF  – NOT USABLE.  NO AGREEMENT. 
BEN  –  NOT RECOMMENDED/NOT SUPPORTED. 
ZZA  –   FIRST 600M (~2,000’) OF RWY 30L NOT AVAILABLE.  10,200’ REMAINING. 
FMH  – PVD TACAN CH103 OTS. 
  
NEXT 2 PLS OPPORTUNITIES: 19 

20 
21 
22 

NOR23 ORB   32 – 1/23:45 SKC 220/14P24 
EDW22 ORB   48 – 3/00:06 SKC 250/15P25 
 
OMS TANK FAIL CAPABILITY: 23 

24 
25 
26 

L OMS FAILS:  NO 
R OMS FAILS: NO 
 
LEAKING OMS PRPLT BURN: 27 

28 
29 
30 

L OMS LEAK:       ALWAYS BURN RETROGRADE 
R OMS LEAK:      ALWAYS BURN RETROGRADE 
 
OMS QUANTITIES(%) 31 

32 
33 
34 
35 

L OMS  OX = 29.8 R OMS OX = 30.2 
 FU = 29.5 FU = 30.2 
 
 
DELTA V AVAILABLE: 36 

37 OMS  274 FPS 
ARCS (TOTAL ABOVE QTY1)  30 FPS 38 

39 
40 
41 
42 
43 
44 
45 
46 
47 
48 
49 
50 

 
TOTAL IN THE AFT 304 FPS 
 
ARCS (TOTAL ABOVE QTY2) 58 FPS 
FRCS (ABOVE QTY 1) 30 FPS 
 
AFT QTY 1 83 % 
AFT QTY 2 45 % 
 
 
 
THERE ARE NO FAILURE/IMPACT/WORK AROUNDS FOR TODAY. 

END OF PAGE 1 OF 1, MSG 007 



MSG 008 - FD03 RNDZ PACKAGE 

  FLIGHT NOTE 1 
2 
3 
4 
5 
6 
7 
8 
9 

10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 

      ---------------------------------------------------------------  
TO: FD, CAPCOM, FAO, RENDEZVOUS, PROP, GC               
FROM: FDO                                                
SUBJECT: MANEUVER TIGS                                
      
COPIES:  1                                                
      
 MET                                          
NC-4      001:16:42:23.400                                  
NCC       001:17:16:32.000                                    
TI        001:18:14:14.000  PET = 0:0 ; SS - 36 MIN           
MC1       001:18:34:14.000                                    
MC2       001:19:04:08.000  ET = 0:0                        
MC3       001:19:21:08.000  MC2 + 17 MIN                     
MC4       001:19:31:08.000  MC2 + 27 MIN                    
DOCK    001:20:52:00.000          
 
 
 
                         
      

 23 
24 
25 
26 

 
 
 

END OF PAGE 1 OF 04, MSG 008 
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 1 

 2 
3 
4 
5 
6 
7 
8 
9 

10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 
25 
26 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

END OF PAGE 2 OF 04, MSG 008 



PRELIMINARY ORBIT MANEUVER PAD FOR NC-4 (Rndz. C/L pg. 3-4)

(+) 0 0 8 . 3
(+) 0 0 0 . 0
(+) 0 0 0 . 1

X

X

X

X
X

N / A

N / A
N / A

N / A

N / A
N / A

1 3

X

 
 

X

0 0 0

(+) 0 . 5
(+) 4 . 6
(-) 4 . 6

2 4 8 0 8 4

0 1 / 1 6 : 4 2 : 2 3 . 4

0 9 7
2 1 7
0 4 0

0 0 8 . 3
0 0 : 1 1

(+) 0 0 7 . 9
(-) 0 0 1 . 6
(+) 0 0 2 . 2

1 8 3 (+) 1 7 8

X

MSG 008 - FD03 RNDZ PACKAGE

END OF PAGE 3 OF 04, MSG 008



(-)      
(-)      

(-)      

0 1 / 1 9 : 4 5 : 3 1 . 0

 

PRELIMINARY ORBIT MANEUVER PAD FOR Ti (Rndz C/L pg. 3-6)

(+) 0 0 7 . 4
(-) 0 0 0 . 4
(+) 0 0 0 . 0

X X

X

X
X

N / A
N / A
N / A

N / A
N / A
N / A

1 3

X

 
 

X

0 0 0

(+) 0 . 5
(+) 4 . 6

(-) 4 . 6

2 4 7 8 6 6

0 1 / 1 8 : 1 4 : 1 4 . 0

0 9 5

2 2 1
0 3 9

0 0 7 . 4

0 0 : 0 9

(+) 0 0 7 . 0

(-) 0 0 1 . 4
(+) 0 0 1 . 9

1 8 4 (+) 1 8 2

X

END OF PAGE 4 OF 04, MSG 008

MSG 008 - FD03 RNDZ PACKAGE



17-0313 (MSG 010) – Stowage Locations for FD03 Plan (GMT 154/155) 
Page 1 of 5 

Page 1 of 5, 17-0313 (MSG 010) 

Contents: 
Timeline Procedures: 
IMMN-FE2U SALIVA-S/U 
IWIS-ORBTR RSU-PREP 
IWIS-S/U 
ISS-HATCH LEAK CK-DK 
ISS-HATCH OPEN 
P/TV-EVA DCS-CNFG 
**ACS-O2 P/B CONFIG 
**IWIS-ACCEL-INSTALL 
 
Timeline Procedures: 
 
IMMN-FE2U SALIVA-S/U  
2.002 SALIVA COLLECTION FOR INTEGRATED IMMUNE 
Type: Standard IMS Plan: No 
# LOCATION ITEM NAME P/N S/N B/C Notes 
1  LAB1O5_F2 Integrated Immune Saliva Collection Kit 

 
SJG46121521-301 1005 

1007 
HRF07569J 
HRF07567J 

NOTIFY POIC if different 
S/N used from this 
location. 
Important for future crew 
ops. 

 
IWIS-ORBTR RSU-PREP 
16-0778 IWIS RSU and Power Cable Installation/Removal  
Type: Standard IMS Plan: No 
# LOCATION ITEM NAME P/N S/N B/C Notes 
1 US DC Power Cable, 10ft SEZ39129260-309 6026 POC10637J  
2 

NOD1S4_C2 
1.0 CTB 
S/N 1189 

B/C 006685J 

A31p 120V DC Power Supply SEG33116412-303 1341 POC10348J  

  3 IWIS Power Cable 528-21376-1 1005   
4 IWIS Remote Sensor Unit (RSU) 

Assembly 
SEG16102889-301 1029  Has been labeled with 

upgraded P/N 
SEG16102889-302 

5 

LAB1P5_A1 
0.5 CTB: IWIS CTB, 

S/N 1188, B/C 
006637J  

WIS Antenna 0060-04-005 - -  
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IWIS-S/U 
16-1168 IWIS SETUP AND PROGRAM - LAB, NODE 1, NODE 2, FGB AND SM 
Type: Standard IMS Plan: No 
# LOCATION ITEM NAME P/N S/N B/C Notes 
1 WIS NETWORK CONTROL UNIT SEG16102890-301 1032 WISN1032J Backup NCU. 
2 

LAB1P5_A1 
0.5 CTB: IWIS CTB, 

S/N 1188, B/C 006637J 
WIS Antenna 0060-04-005 - -  

3 Мешок - - 008153R  
4      IMAX Russian Ground Cable 1.5' SEZ39134181-301 1008 00006460J  
5           IMAX Russian Adapter Cable 1' SEZ39134178-301 1004 00006432J  
6               IMAX 28VDC Y-Cable 2' SEZ39134173-301 1003 00003593J  
7                   DC Power 28VDC Cable Assy SEG39129264-301 6008 POC01023J  
8                         A31p 28V DC Power Supply SEG33116428-301 1301 POC10404J  
9                              IWIS Power Cable 528-21376-1 1006 00063522J  
10                                      IWIS Remote Sensing Unit SEG16102889-301 1035 00011461J FGB RSU; Has 

been labeled with 
upgraded P/N 
SEG16102889-
302  

11                                         WIS Antenna 0060-04-005 - -  
12 IMAX Russian Ground Cable 1.5' SEZ39134181-301 1005 00006462J  
13       PEEK 28 VDC 20AMP Russian Outlet Adapter Cable SEG33112678-301 1002 00006801J  
14            IMAX 28VDC Y-Cable 2' SEZ39134173-301 1010 004493J  
15                 Orb DC Power Cable 10' SEG39129264-303 5014 -  
16                       A31p 28V DC Power Supply SEG33116428-301 1014 00045846J  
17                            IWIS Power Cable 528-21376-1 1007 00063523J  
18                                   IWIS Remote Sensor Unit Assembly SEG16102889-301 1027 WISI1027J SM RSU; Has 

been labeled with 
upgraded P/N 
SEG16102889-
302 

19 

ФГБ1ПГО_2_224_1 
0.5 CTB: CTB,  

S/N 1395,  
B/C CTB00301J 

                            WIS Antenna 0060-04-005 - -  
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ISS-HATCH LEAK CK-DK 
2.102 POST DOCKING HATCH LEAK CHECK - ISS 
Type: Standard IMS Plan: No 
# LOCATION ITEM NAME P/N S/N B/C Notes 
1 NOD1P4_D VAJ-78-1 5ft 683-17111-1 - 00002677J  
2 MPEV INTERNAL SAMPLING ADAPTER 97M55830-1 2 000002M AKA - ISA 
3 ISA Scopemeter Pressure Probe 1525,760MMHGA/30

PSIA 
00502343

9991 
000009M  

4 Multimeter Kit 10118-10018-04 1017 -  
5 

NOD1O4_D1 
0.5 CTB, S/N 1202, 

B/C 006651J  
 

Multimeter 87 - 00059824J Named “E16RULES.” 
6 Crew Pref Earplugs - - -  

 
 
ISS-HATCH OPEN 
2.104 HATCH OPENING AND SHUTTLE/ISS DUCT INSTALLATION 
Type: Standard IMS Plan: No 
# LOCATION ITEM NAME P/N S/N B/C Notes 
1  Nitrile Gloves Assy SEG33116807-301 - - Substitute for Rubber 

Gloves if none found. 
2  

NOD1O4_C1 
0.5 CTB: Rubber 

Gloves, S/N 1159, 
B/C 006608J 

Deerskin Gloves 528-41517-2 - -  

3  Crew Preference Towel - - -  
4  LAB1 Deployed Spotlight 528-20184-1 - -  
5  Ручка  11Ф732.Г1021-ОА - - APAS Hatch Tool 
6  CLEANING PADS 33У.9938.002 - -  
7  1 1/2 INCH WRENCH 528-20942-1 - - 1 1/2" Open End Wrench 
8  HATCH COVER 33У.9936.021 - - APAS Hatch Cover 
9  Standoff Cover Bag Assy SEM39125998-301 - - Docking Target Standoff 

Cross Bag 
10 

NODE2 FWD 
ENDCONE 
DOCKING 

MECHANISM 
ACCESSORY KIT, 
P/N 33У.9962.003 

Target Base Cover Assy SEM39125997-301 - - Docking Target Base 
Plate Cover 
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P/TV-EVA DCS-CNFG 
2.702 760 EVA CAMERA WITH FLASH & 2.701 760 EVA CAMERA 
Type: Standard IMS Plan: No 
# LOCATION ITEM NAME P/N S/N B/C Notes 
1 1GB EVA Flash Card [QTY: 4] SEZ33118356-301 Any Any B/U cards for RPM Photos 
2 

ISS DEPLOYED 
DCS 760 Camera [QTY: 2] SEZ33113001-304 Any -  

3 LAB1D3 Deployed DCS Rechargeable Battery  [QTY: 3] SDZ33112993-802 Any - Use freshly charged 
batteries. 

4 28 mm EVA Lens SED33105019-301 Any -  
5 EVA Filter w/o Glass  SEZ33114460-304 Any Any  
6 50 mm EVA Lens  SED33104372-302 Any Any  
7 EVA Filter w/o Glass  SEZ33114460-304 Any Any  
8 Camera Mtg Assy Thermal Blanket  [QTY: 2] SED33117417-301 Any -  
9 Camera Mounting Assy  [QTY: 2] SED33113695-302 Any -  
10 EVA Camera Blanket [QTY: 2] SEZ33113449-301 Any Any  
11 28mm. 35mm. 50mm Lens Cap [QTY: 2] SED33110611-327 Any Any Attached to Camera 

Blankets 
12 EVA Action Finder [QTY: 2] SED33110611-327 Any Any  
13 

A/L1D2_Behind 
Closeout  

1.0 CTB: EVA 
CAMERA 

ACCESSORIES 
S/N 1221,  

B/C  006717J 
 

 Tie Wrap [QTY: 4] SDD13101649-302 - - AKA: Zip Ties 
 
CONFIRM to MCC-H total 
number of Tie Wraps used 
for inventory 
management. 

14 EVA Flash SEG33111838-307 Any Any  
15 Bracket Assembly Thermal Blanket SED33117416-301 Any -  
16 Bracket Assembly SED33117404-301 Any -  
17 DCS EVA 7VDC Power Cable SEZ33117255-301 Any -  
18 EVA Remote Cord SED33112525-302 Any -  
19 Flash Sync Cover SEZ33113449-308 Any -  
20 

A/L1D0  
Behind closeout  

1.0 CTB: EVA FLASH 
S/N 1105, B/C 

004099J 

Flash Sync Cable SEZ33117231-301 Any -  
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**ACS-O2 P/B CONFIG 
3.120 PREBREATHE USING SHUTTLE O2 SETUP 
Type: Standard IMS Plan: No 
# LOCATION ITEM NAME P/N S/N B/C Notes 
1  Clean Room Gloves SEG33116979-301 - - 
2  GO2 Transfer Hose Assy V857-643003-002 AA0873793 002668-1J 
3  Flashlight - - - 
4  Earplugs - - - 
5  Teflon Bag 300045-08 - - 
6  Clean Room Vinyl Tape 3M/1251 - - 
7  

LAB1O3 
Mesh Bag 

 
 
 

Inspection Mirror 1016T2 - - 

These items were 
pregathered into a mesh 
bag by the ISS crew. 

 
**IWIS-ACCEL-INSTALL 
3.129 IWIS Installation in Shuttle Airlock 
Type: Standard IMS Plan: No 
# LOCATION ITEM NAME P/N S/N B/C Notes 
1 IWIS Accelerometer Cable Assy 25 FT 0060-04-013 1004 WISTAA05J  
2      Accelerometer Interface Plate 0060-04-015 1008 00050648J  
3 

LAB1P5_A1 
0.5 CTB: IWIS CTB, 

S/N 1188, B/C 
006637J 

          Accelerometer 0060-04-012 1005 WISTAA05J  
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1)  FS 2-10, Step 3 - When you’re moving STS-124/1J EMERGENCY UNDOCK EVA 
TRANSFER CUE CARD make the following change to that CUE CARD:  

1 
2 
3 
4 
5 
6 
7 
8 
9 

10 
11 
12 
13 
14 
15 
16 
17 
18 
19 
20 
21 
22 
23 
24 
25 
26 
27 
28 
29 
30 
31 
32 
33 
34 
35 
36 
37 
38 
39 
40 
41 
42 
43 
44 
45 
46 
47 
48 
49 
50 

* under “Critical” add a step 8. External A/L Floor (Bag I)  
 
 
Rationale:   A/L Floor (Bag 1) contains Contingency   
      -     CCC (LiOHs – 4 cans)  

- Backup and Contingency gloves 
- MWS 

 
2)  FS 2-10, Step 5 – Delete “Cuff Checklists” 
3)  FS 2-15, Mesh Bag (EVA Systems 1) block – Delete “Cuff Checklists (Old from ISS)” 
4)  FS 2-17, Step 2 – Delete “ISS Cuff Checklists” 
 
Rationale:  Garrett has already pre-packed 6 cuffs in 1J return bag 404 during EMU 
Relocate. 
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DOUG Setup for 1J Robotics 1 

 2 

1. This DOUG load contains the EVA Reconfig Menus as well as the SSRMS 3 

procedure states, and the SSRMS, SRMS, and JEM RMS targets. 4 

2. For stand-alone procedure review, perform { Uplinked Procedures; US SODF: 5 

POC; 17-0278 1.301 DOUG Startup Procedure}, step 2  6 

3. For SSRMS real-time support, perform { Uplinked Procedures; US SODF: POC; 7 

17-0278 1.301 DOUG Startup Procedure}, step 1 8 

3.1 Set SSC volume such that tones are audible. 9 

4. All DOUG States will have the SSRMS configured in its ‘zero’ position. For stand 10 

alone procedure review use the Options ► SSRMS Targets dialog box to find 11 

your starting SSRMS target. For SSRMS real-time support, the SSRMS will 12 

update its joint angles when DOUG is receiving telemetry. 13 
 14 

Notes: 15 

1. Use the Options ► SSRMS Targets dialog box to find your starting SSRMS 16 

target and ensure ‘Targ SSRMS’ is checked. 17 

2. Use the Home Key to cycle through the Camera, SSRMS & SRMS Targets.   18 

3. Use Page Up and Page Down keys to scroll through Target selections. 19 

4. Reconfig notes should be executed at end of maneuver 20 

5. Display ► Puddle Plot Shoulder/Wrist 21 

6. For real-time support, Display ►Show SSRMS Target 22 

7. For Real-time support, Options ►SSRMS Proximity, set all distances to 24 23 

(inches) 24 

8. For Real-time support, ‘Shift’+’V’ will display the VPP (Vegas) vector tool in the 25 

lower right corner 26 
 27 

FD4 Targets 28 

OBSS Grapple 29 

File ► Load State  30 

From Load State Dialog box, select ‘FD4_1.101_Mnvr_to_OBSS_Grapple’, 31 

open 32 

Confirm Load State is complete with loaded state file, otherwise complete these 33 

steps as needed. 34 

Reconfig ► 35 

SSRMS > SSRMS_BASE_A 36 

SSRMS > SSRMS ->MBS_PDGF3 37 

SSRMS > MT_to_WORKSITE_4 38 

JEM_PM  > JEM_PM->Bay 39 

JEM_ELM  > JEM_ELM->NODE2 40 

 Orbiter_Inspection > Stow _OBSS_on_S1 41 
 42 

Procedure Step SSRMS Notes 
1.101 Mnvr to 
OBSS Grapple   

2 1.101 Park Position  

 3 1.101 OBSS Pre-Grapple  
 6.3 1.101 OBSS Captured Reconfig >Orbiter_Inspection> 

OBSS_GF2_to_SSRMS 
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OBSS Handoff 1 

File ► Load State  2 

From Load State Dialog box, select 3 

‘FD4_1.102_OBSS_Unberth_and_Handoff’, open 4 

Confirm Load State is complete with loaded state file, otherwise complete these 5 

steps as needed. 6 

Reconfig ►  7 

SSRMS > SSRMS_BASE_A 8 

SSRMS >  SSRMS ->MBS_PDGF3 9 

SSRMS > MT_to_WORKSITE_4 10 

JEM_PM > JEM_PM->Bay 11 

JEM_ELM > JEM_ELM->NODE2 12 

Orbiter_Inspection > OBSS_GF2_to_SSRMS 13 

RMS Target = OBSS Pregrapple at Handoff 14 
 15 

1.102 OBSS 
Unberth and 
Handoff 

3 1.102 OBSS Grapple  

 4 1.102 Cable Removal  
 5 1.102 JOCAS Start  
 6 1.102 OBSS Handoff RMS Target = OBSS Handoff 

Reconfig >Orbiter_Inspection> 
OBSS_GF1_to_SRMS 

1.103 OBSS 
Ungrapple to 
Node 2 
Grapple 

2.3 1.103 OBSS Back-Off  

 3 1.103 Intermediate Position  
 4 1.103 Node 2 Approach  
 5 1.103 Node 2 Pre-Grapple 

(+SP) 
 

 8 1.103 Node 2 Grapple  
 16 

JPM Install 17 

File ► Load State  18 

From Load State Dialog box, select ‘FD4_2.101_Mnvr_to_JPM_Grapple’, 19 

open 20 

Confirm Load State is complete with loaded state file, otherwise complete these 21 

steps as needed. 22 

Reconfig ► 23 

SSRMS > SSRMS_BASE_B’. 24 

SSRMS > SSRMS ->Node2_PDGF 25 

SSRMS > MT_to_WORKSITE_4 26 

JEM_PM > JEM_PM->Bay 27 

JEM_ELM > JEM_ELM->NODE2 28 

Orbiter_Inspection > OBSS_GF1_to_SRMS 29 

RMS Target =JPM Install Viewing 30 

 31 

 32 
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2.101 Mnvr to 
JPM Grapple 

1 2.101 MBS PDGF 3 Grapple  

 2.4 2.101 MBS PDGF 3 Release  
 3 2.101 Intermediate Position 1  
 4 2.101 Intermediate Position 2  
 5 2.101 JPM Pre-Grapple  
 8 2.101 JPM Grappled Reconfig-> JEM_PM> 

JEM_PM_PDGF->SSRMS 
2.102 JPM 
Install 

1 2.102 JPM Grappled  

 7 2.102 JPM Unberth  
 9 2.102 JAUTO Start  
 11 2.102 JAUTO 1  
  2.102 JAUTO 2  
  2.102 JPM Pre-Install  
 14 2.102 JPM Ready-To-Latch  
 16 2.102 JPM Install Reconfig-> JEM_PM> JEM_PM-

>Node2 
 1 

FD6 Targets 2 

JPM Release 3 

File ► Load State  4 

From Load State Dialog box, select 5 

‘FD6_2.103_JPM_Release_and_Walkoff_to_MBS_PDGF3’, open 6 

Confirm Load State is complete with loaded state file, otherwise complete these 7 

steps as needed. 8 

Reconfig ► 9 

SSRMS > SSRMS_BASE_B 10 

SSRMS > SSRMS ->Node2_PDGF 11 

SSRMS > MT_to_WORKSITE_6 12 

JEM_ELM  > JEM_ELM->NODE2 13 

JEM_PM  > JEM_PM->NODE2 14 

JEM_PM  > Install_JEM_FWD_Camerea_and_Boom 15 

JEM_PM  > Install_JEM_AFT_Camerea_and_Boom 16 

Reconfig> JEM_PM> Remove_CBM_MLI 17 

Orbiter_Inspection > OBSS_GF1_to_SRMS. 18 

RMS Target =JPM Install Viewing 19 
 20 
2.103 JPM 
Release and 
Walkoff to 
MBS PDGF 3 

1 2.103 JPM Install  

 2.3 2.103 JPM Release  
 3 2.103 JPM Clear  
 4 2.103 Intermediate Position (-

SP) 
 

  2.103 Intermediate Position (-
SR) 

 

 5.1 2.103 PDGF3 Approach  
 5.2 2.103 MBS PDGF 3 Pre-  
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Grapple 
 8 2.103 MBS PDGF 3 Grapple  
 1 

FD7 Targets 2 

Node 2 Release and Focus Inspection Support 3 

File ► Load State  4 

From Load State Dialog box, select 5 

‘FD7_2.103_JPM_Release_and_Walkoff_to_MBS_PDGF3’, open 6 

Confirm Load State is complete with loaded state file, otherwise complete these 7 

steps as needed. 8 

Reconfig ► 9 

SSRMS > SSRMS_BASE_A. 10 

SSRMS > SSRMS ->MBS_PDGF3 11 

SSRMS > MT_to_WORKSITE_6 12 

JEM_ELM  > JEM_ELM->NODE2 13 

JEM_PM > JEM_PM->NODE2 14 

JEM_PM  > Install_JEM_FWD_Camerea_and_Boom 15 

JEM_PM  > Install_JEM_AFT_Camerea_and_Boom 16 

Reconfig> JEM_PM> Remove_CBM_MLI 17 

Orbiter_Inspection > OBSS_GF1_to_SRMS. 18 

RMS Target =JPM Install Viewing 19 

 20 

2.103 JPM 
Release and 
Walkoff to 
MBS PDGF 3 

9 2.103 Node2 Grapple  

 10.3 2.103 Node2 Release  
3.101 Mnvr to 
Focused 
Inspection 
Support 

1 3.101 Node2 Release  

 2 3.101 Clear of JPM  
 3 3.101 FI Support  
 21 

JLP Relocate 22 

File ► Load State  23 

From Load State Dialog box, select 24 

‘FD7_4.101_Mnvr_from_FI_Support_to_JLP_Pre-Grapple’, open 25 

Confirm Load State is complete with loaded state file, otherwise complete these 26 

steps as needed. 27 

Reconfig ► 28 

SSRMS > SSRMS_BASE_A 29 

SSRMS > SSRMS ->MBS_PDGF. 30 

SSRMS > MT_to_WORKSITE_6 31 

JEM_ELM > JEM_ELM->NODE2 32 

JEM_PM >JEM_PM->NODE2 33 

JEM_PM  > Install_JEM_FWD_Camerea_and_Boom 34 

JEM_PM  > Install_JEM_AFT_Camerea_and_Boom 35 

Reconfig> JEM_PM> Remove_CBM_MLI 36 
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Orbiter_Inspection > OBSS_GF1_to_SRMS 1 

RMS Target = JLP Relocate Viewing 2 

 3 

4.101 Mnvr 
from FI 
Support to JLP 
Pre-Grapple 

1 4.101 FI Support  

 2 4.101 JLP Approach  
 3 4.101 JLP Pre-Grapple  
4.102 JLP 
Relocate 

1 4.102 JLP Pre-Grapple  

 2 4.102 JLP Grapple Reconfig> JEM_ELM> 
JEM_ELM_GF2->SSRMS 

 5 4.102 JLP Unberth  
 9 4.102 JLP Pre-Install  
 12 4.102 JLP RTL  
 14 4.102 JLP Install Reconfig> JEM_ELM> JEM_ELM-> 

JEM_PM 
4.103 JLP 
Ungrapple to 
JEM RMS 
Viewing 

1 4.103 JLP Install  

 2.3 4.103 JLP Release  
 3 4.103  JEM RMS Viewing  
 4 

FD8 Targets 5 

Mnvr to EVA 3 Start 6 

File ► Load State  7 

From Load State Dialog box, select 8 

‘FD8_5.101_JEMRMS_Deploy_Viewing_to_EVA3_Start’, open 9 

Confirm Load State is complete with loaded state file, otherwise complete these 10 

steps as needed. 11 

Reconfig ► 12 

SSRMS > SSRMS_BASE_A 13 

SSRMS > SSRMS ->MBS_PDGF3. 14 

SSRMS > MT_to_WORKSITE_6 15 

JEM_ELM > JEM_ELM->JEM_PM 16 

JEM_PM > JEM_PM->NODE2 17 

JEM_PM  > Install_JEM_FWD_Camerea_and_Boom 18 

JEM_PM  > Install_JEM_AFT_Camerea_and_Boom 19 

Orbiter_Inspection > OBSS_GF1_to_SRMS 20 

RMS Target = EVA3 Viewing 21 

JEM Target = 1.104 Step 8.7 Partial Deploy Position 22 
 23 
5.101 JEM 
RMS 
Viewing to 
EVA3 Start 

1 5.101 JEM RMS Viewing  

 2 5.101 EVA3 Start Position 
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FD9 Targets 1 

NTA R&R 2 

File ► Load State  3 

From Load State Dialog box, select ‘FD9_5.102_S1_NTA_Install’, open 4 

Confirm Load State is complete with loaded state file, otherwise complete these 5 

steps as needed. 6 

Reconfig ► 7 

SSRMS > SSRMS_BASE_A 8 

SSRMS > SSRMS ->MBS_PDGF3. 9 

SSRMS > MT_to_WORKSITE_6 10 

JEM_ELM > JEM_ELM->JEM_PM 11 

JEM_PM > JEM_PM->NODE2 12 

JEM_PM  > Install_JEM_FWD_Camerea_and_Boom 13 

JEM_PM  > Install_JEM_AFT_Camerea_and_Boom 14 

Orbiter_Inspection > OBSS_GF1_to_SRMS 15 

RMS Target = EVA3 Viewing 16 

JEM Target = 1.104 Step 8.7 Partial Deploy Position 17 

 18 

5.102 S1 
NTA 
Retrieve 

1 5.102 EVA3 Start Position  

 2 5.102 WIF Extender/APFR Install Reconfig-> EVA_3_SSRMS_Setup> 
WIF_Extender&APFR_to SSRMS 

 3 5.102 APFR Rotate  
 4 5.102 APFR Backoff  
 4 5.102 APFR Ingress Reconfig-> EVA_3_SSRMS_Setup> 

EV2_on_APFR 
 5 5.102 S1 NTA Retrieve Reconfig-> EVA_3_SSRMS_Setup> 

S1_NTA_to_EV2 
 6 5.102 JOCAS Start  
 7 5.102 ESP3 Backoff Reconfig-> EVA_3_SSRMS_Setup> 

Temp_Stow_Spare_NTA 
5.103 NTA 
Retrieve at 
ESP3 

1 5.103 ESP3 Backoff  

 2 5.103  Old NTA Pre Stow  
 3 5.103  Old NTA Final Stow Reconfig-> EVA_3_SSRMS_Setup> 

S1_NTA_Stow_on_ESP3 
 4 5.103 New NTA Retrieve Reconfig-> EVA_3_SSRMS_Setup> 

SPARE_NTA_to_EV2 
 5 5.103 Return JOCAS Start  
 19 

 20 

 21 

 22 

 23 

 24 

 25 

 26 

 27 



17-0279A (MSG 012A) – 1J SSRMS and JEM RMS DOUG Setup Notes 
Page 7 of 9 

Page 7 of 9, 17-0279A (MSG 012A) 

5.104 S1 
NTA Install 

1 5.104 Return JOCAS Start  

 2 5.104 S1 NTA Pre-Install  
 3 5.104 S1 NTA Install Reconfig-> EVA_3_SSRMS_Setup> 

SPARE_NTA_to_S1_Truss 
 4 5.104 APFR Egress Reconfig-> EVA_3_SSRMS_Setup> 

EV2_off_APFR 
 5 5.104 APFR Backoff  
 5 5.104 APFR Rotate  
 5 5.104 APFR/WIF Removal Reconfig-> EVA_3_SSRMS_Setup> 

WIF_Extender&APFR_off_SSRMS 
 6 5.104 SSRMS Clear  
 7 5.104 Stage Park  
 1 

JEM RMS  2 

For stand-alone procedure review, perform {1.402 JEMRMS DOUG STARTUP}, 3 

step 2 (JAXA_SODF: Robotics: Activation and Checkout) 4 

 5 

For JEMRMS real-time support, perform {1.402 JEMRMS DOUG STARTUP}, step 6 

1 (JAXA_SODF: Robotics: Activation and Checkout) 7 

Note:  In step 1.9 select:  8 

JEMRMS if only JEMRMS joint angle telemetry is desired. 9 

 JEMRMS & SSRMS if only JEMRMS and SSRMS joint angle telemetry is 10 

desired  11 

 12 

For FD 8 13 

File ► Load State  14 

From Load State Dialog box, select 15 

‘FD8_1.104_JEMRMS_Partial_Deploy_to_EVA3_Start’, open 16 

Confirm Load State is complete with loaded state file, otherwise complete these 17 

steps as needed. 18 

Reconfig ► 19 

SSRMS > SSRMS_BASE_A 20 

SSRMS > SSRMS ->MBS_PDGF3. 21 

SSRMS > MT_to_WORKSITE_6 22 

JEM_ELM > JEM_ELM->JEM_PM 23 

JEM_PM > JEM_PM->NODE2 24 

JEM_PM  > Install_JEM_FWD_Camerea_and_Boom 25 

JEM_PM  > Install_JEM_AFT_Camerea_and_Boom 26 

Orbiter_Inspection > OBSS_GF1_to_SRMS 27 

RMS Target = EVA3 Viewing 28 

SSRMS Target = 4.103 JEM RMS Viewing 29 

 30 

 31 

 32 

 33 

 34 

 35 

 36 
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For FD 10 1 

File ► Load State  2 

From Load State Dialog box, select ‘FD10_1.105_JEMRMS_Final_Deploy’, 3 

open 4 

Confirm Load State is complete with loaded state file, otherwise complete these 5 

steps as needed. 6 

Reconfig ► 7 

SSRMS > SSRMS_BASE_A 8 

SSRMS > SSRMS ->MBS_PDGF3. 9 

SSRMS > MT_to_WORKSITE_6 10 

JEM_ELM > JEM_ELM->JEM_PM 11 

JEM_PM > JEM_PM->NODE2 12 

JEM_PM  > Install_JEM_FWD_Camerea_and_Boom 13 

JEM_PM  > Install_JEM_AFT_Camerea_and_Boom 14 

Orbiter_Inspection > OBSS_GF1_to_SRMS 15 

RMS Target = JEM RMS Viewing 16 

SSRMS Target = 5.104 Stage Park 17 

 18 

Flight 
Day Procedure Step JEMRMS Target 

 8 

 1.104  JEMRMS 
PARTIAL DEPLOY TO 
EVA 3 START 

1 1.104 Step 2 Launch Position 

  6.2[7] 1.104 Step 6.2[7] WP CO-0.2 
  6.2[12] 1.104 Step 6.2[12] WY CO+0.2 
  6.2[17] 1.104 Step 6.2[17] WR CO-0.2  
  7.3[7] 1.104 Step 7.3[7] WP-8.8 
  7.3[12] 1.104 Step 7.3[12] WY+6.8 
  7.5[5] 1.104 Step 7.5[5] WR-89.8 
  7.7[5] 1.104 Step 7.7[5] WY+81 
  7.9[6] 1.104 Step 7.9[6] EP CO-0.2 
  7.9[11] 1.104 Step 7.9[11] EP-2.8 
  7.11[5] 1.104 Step 7.11[5] SP CO+0.2 
  7.11[10] 1.104 Step 7.11[10] SP+2.8 
  8.2[5] 1.104 Step 8.2[5] SY CO+0.2 
  8.7 1.104 Step 8.7 Partial Deploy Position 

10 
1.105 JEMRMS FINAL 
DEPLOY 4.4 1.105 Step 4.4 SY+67 

  4.4 1.105 Step 4.4 WP+52 
  11.1[8] 1.105 Step 11.1[8] Final Deploy Position 

10 
1.106 JEMRMS MNVR 
TO STOWED POSITION 5.1[8] 1.106 Step 5.1[8] WR-90 

  5.1[13] 1.106 Step 5.1[13] WY-88 
  5.1[18] 1.106 Step 5.1[18] EP-101 
  5.1[23] 1.106 Step 5.1[23] SP+90  
  5.1[28] 1.106 Step 5.1[28] EP-135 
  5.1[33] 1.106 Step 5.1[33] WP+90 
  5.1[38] 1.106 Step 5.1[38] SP+48 
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  5.1[43] 1.106 Step 5.1[43] Stowed Position 

10 
1.107 JEMRMS BRAKE 
CHECKOUT  4.3[7] 1.107 Step 4.3[7] SY Break CO - Initial 

  8.2[8] 1.107 Step 8.2[8] SY Break CO - Complete 
  9[8] 1.107 Step 9[8] SP Break CO -Initial 
  10.2[6] 1.107 Step 10.2[6] SP Break CO - Complete 
  14[8] 1.107 Step 14[8] EP Break CO - Initial 
  15.2[6] 1.107 Step 15.2[6] EP Break CO - Complete 
  17.4 1.107 Step 17.4 Stowed Position 

 1 



CWC FILLS

CWC No. Record S/N Used
Sample Kit 

Ref: Kit Table
Ag Biocide Kit 
Ref: Kit Table

Mineral Kit 
Ref: Kit Table CWC Label

� 1 S/N 1006 (Note A) S/N 1002 S/N 1003 Blue (Pot)

� 2 S/N 1006 (Note A) S/N 1002 S/N 1003 Blue (Pot)

� 3 S/N 1006 (Note A) S/N 1002 S/N 1003 Blue (Pot)

� 4 S/N 1006 (Note A) S/N 1002 S/N 1003 Blue (Pot)

� 5 S/N 1006 (Note A) S/N 1002 Not Req'd Green (Tech)

� 6 S/N 1006 (Note A) S/N 1002 Not Req'd Green (Tech)

� 7 S/N 1006 (Note A) S/N 1002 Not Req'd Green (Tech)

Pre-Fill Checklist:
� Disinfect CWC QD and Transfer Hose QD CWC Fill Notes:

1�  2�  3�  4�  5�  6�  7� A. Stow filled sample bags and purge bag in MF14E
Post-Fill Checklist: B. Rough handling may cause leakage
� Take Sample C. Fill each CWC for 52 min or Term CWC Fill on MCC call

1�  2�  3�  4�  5�  6�  7�
� Check correct label is in CWC window

1�  2�  3�  4�  5�  6�  7�
� Check correct decal on CWC end

1�  2�  3�  4�  5�  6�  7�
� Check correct CWC S/N on end decal

1�  2�  3�  4�  5�  6�  7�
� Report S/N to MCC Kit S/N Undock Location

1�  2�  3�  4�  5�  6�  7� Ag Biocide Kit 1002 MD FLOOR (PORT 2, BAG B)
� Transfer CWC to NOD1D2 Mineralization Kit 1003 MD FLOOR (PORT 2, BAG B)

1�  2�  3�  4�  5�  6�  7� Sample/Purge Kit 1006 MD FLOOR (PORT 2, BAG B)
� Cap Transfer Hose QD between each fill Ag Biocide Kit 1005 ISS NOD2P2 (M-02 Bag S/N 1026)

PWR OPS
PWR No. PWR S/N Actions

� 1 2003 (OGS) Fill and transfer to LAB1P1 (WDS); will return to Shuttle for future dump and fill
� 2 1025 Dump, fill and transfer to ISS A/L1D1_A1
� 3 1007 Post EVA2, dump, fill and transfer to ISS A/L1D1_B2
� 4 2002 (OGS) Dump, fill and transfer to ISS A/L1D1_A1
� 5 2004 (OGS) Dump, fill and transfer to ISS A/L1D1_B2
� 6 2003 (OGS) Dump, fill and transfer to A/L1D1

PWR Fill Notes: Do not detach PWR (EMU H2O Recharge Bag) QD restraint during PWR ops
WDS = Water Delivery System in LAB1P1 Rev B - 06/02/2008  [FD03]
PWR's will be dumped using the Supply Water Dump system

Pregathered Mesh Bag on ISS

Launched in MD FLOOR (PORT 2, BAG B); temp stowed in          
Aki's Water Ops Mesh Bag -- Available Potable S/Ns: 

Aki's Water Ops Mesh Bag (Middeck)
Aki's Water Ops Mesh Bag (Middeck)

Pregathered Mesh Bag is located in
ISS LAB1O3, M-02 Bag S/N 1026

In Pregathered Mesh Bag on ISS; Available Technical S/Ns:           
1030 �     1053 �      1035 �  1076 �

Pregathered Mesh Bag is located in
ISS LAB1O3, M-02 Bag S/N 1026

CWC
Launch Location

1096 �      1098 �                      
[ Do NOT use Condensate CWC 5050 (5051) also in this bag ]

Stowage Location

In Pregathered Mesh Bag on ISS; Available Potable S/Ns:              
1039 �      1079 � 

Aki's Water Ops Mesh Bag (Middeck)

A/L1D1_B2
Temp Stowed post dump

Stowage Location
Aki's Water Ops Mesh Bag (Middeck)

A/L1D1_A2
A/L1D1_A2
A/L1D1_B2
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